
Viewing and Managing Funding Opportunities
As a user, you can view and track funding opportunities, and you can enable funding alerts. These tasks are described on
this page.

Viewing Funding Opportunities
Each funding opportunity displays important information about the opportunity, as well as the following information / actions:

• Opp ID – This ID uniquely identifies the opportunity in Pivot. You can search for this ID using a basic search.
• Website – Select to open the URL associated with this opportunity.
• Sponsor(s) – Select a sponsor to see other opportunities by that sponsor.
• Keywords – Select a keyword to see other opportunities that share a category with this one.
• Upcoming Deadlines – See upcoming deadlines associated with this opportunity. For more information, see

Deadlines.
• Track / Set to Active – See Tracking Funding Opportunities, below.
• Potential Collaborators – Select to view profiles of researchers working in the area related to this funding opportunity.

Select one or more of the profiles and select Share to share the opportunity with them. Sharing funding opportunities
works exactly the same way that sharing saved searches works; see Saving and Rerunning Searches for Funding
Opportunities, above.

• Share – Select to share the opportunity with specific researchers or groups. Sharing funding opportunities works
exactly the same way that sharing saved searches works; see Saving and Rerunning Searches for Funding
Opportunities.

• Add Tags or Edit Tags – Select to add, edit, or remove tags. Tagging funding opportunities works exactly the same
way that tagging saved searches works; see Saving and Rerunning Searches for Funding Opportunities, above.

• See more opps like this – Select to view other opportunities that Pivot considers similar to this one.
• Send feedback – Select to email Ex Libris any comments you have about this funding opportunity.
• Start Proposal in Cayuse – When enabled by your institution, select to manage this grant proposal in Cayuse. See

Opening Cayuse from Pivot.

As an administrator, you can:

• Find and suggest funding opportunities to your institution's users. See Creating Curated Lists of Funding
Opportunities.

• Create and manage internal funding opportunities that are local to your institution. See Managing Internal
Funding Opportunities.

• Add a funding opportunity search widget to your website. See Adding a Funding Opportunity Search
Widget to Your Website.

In addition, you can mark funding opportunities with local notes and deadlines. See below.

You can also view detailed reports about how Pivot is being used by users in Viewing Pivot Reports and
Statistics.
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Funding Opportunity Details

When viewing an opportunity, an administrator can:

• Add the opportunity to a curated list – See Creating Curated Lists of Funding Opportunities.
• See the list of users that have set alerts for the opportunity – See Enabling or Disabling Email Funding

Alerts.
• Add a deadline to the opportunity – For more information, see Managing Deadlines and Deadline

Reminders.
• Add a local note that appears on the funding opportunity. An administrator can also add a global note

that appears on all funding opportunities. See Creating a Global Message and Site Announcements.
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Exporting Funding Opportunities
You can export funding opportunities in various output formats.

To export funding opportunities:

1. From any list of funding opportunities (search results, curated list, and so forth), select the opportunities to export and
select Export (the Export option appears only after you select one or more opportunities).

To add a local note to a specific funding opportunity:

You add, edit, and delete local notes when viewing the funding opportunity. When adding a note, you can
select to make the note private. In this case, only you see the note (no other users).

To delete a note, select Edit and select Delete.

Funding Opportunity Details, Admin
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The Export Funding Opp Details dialog box appears.

2. Select the output format. If you select HTML or ASCII formats, then you can also select Include search strategy to
include the search parameters and filters in your export.

3. Select how much of the record content you want to export. If you select Select your field, you can select or clear
specific fields from the output.

Funding Opportunities List

Export Funding Opp Details
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4. Select Submit. If you selected HTML, the results appear in your browser. Otherwise, the results are downloaded to
your computer.

Facet Filtering and Sorting
All search results include facets and sorting options. You can select a facet as a quick way to filter the current list of results.

Your administrator may have set default filters for location or citizenship; see Configuring Institution Search Settings. You
can clear these filters (select X) at the top of the facets pane.

Saving and Rerunning Searches for Funding Opportunities
You can save your searches for funding opportunities. This saves you from having to enter the criteria every time you want
to run this search. A saved search is, effectively, a dynamic list of opportunities that match certain criteria. Every time you

Export Funding Opp Details – Select Your Fields

Facets and Sort
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run a saved search, the list of opportunities returned may change.

You can share your saved searches with other users (and they can share theirs with you).

To save a search:

1. Select Save Search on a search results page.

The Save Your Search dialog box appears.

2. Enter a name for the search and select whether you would like to receive a weekly email with results of this search.
Note that you can toggle the alerts setting on or off after the search is saved.

3. Select Save to save your search and click OK in the confirmation message.

To run or manage your saved searches:

Saved searches appear on your home page; see Pivot's User Interface. If you have added any tags to your saved
searches, you can filter your searches by selecting the tag in the left sidebar.

Search Results

Save Your Search

Home Page – Saved Searches Tab
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Searches that were added to your profile by an administrator appear with an indication (

). Use the row actions to view, view historical results of, share, edit. tag, toggle alerts on/off for, or delete the search.

To view historical results of a saved search:

Select View Archived Results in a saved search row. Pivot's displays search results for the saved search over the past
week. Additional weeks are available in the facets in the left sidebar.

To add tags to a saved search, or to edit tags of a saved search:

1. Select Add Tags or Edit Tags in a saved search row. The Add Tags or Edit Tags dialog box appears.

2. Select from any already defined tags, or clear existing tags, and select Add or Apply. The selected tags are added
and any cleared tags are removed.

To add a new tag, enter a new tag and select Create New. The New Tag dialog box appears.

3. Select Create.

To share a saved search:

1. Select Share in a saved search row. The Share dialog box appears.

Add Tags

New Tag
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2. Enter one or more recipients (users or groups) with which to share the search. This field uses auto-complete. For
more information about groups, see User Groups.

3. Enter an optional message and select whether recipients can see all other recipients of your suggestion.
4. Select Send.

Share

As an administrator, when sharing a search, you can select to add the search to the user(s) saved searches.
The search appears with an indication that it was added by an administrator (see above).

Share (Admin)
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Tracking Funding Opportunities
You can:

• Tag funding opportunities to view at a late time in Pivot.
• Enable email alerts for opportunities or saved searches.
• Add personal deadlines to opportunities.
• View a list of funding opportunity deadlines in a calendar and export these deadlines to a personal calendar

application.

Tracking Funding Opportunities in Pivot
You can tag funding opportunities with two levels of importance:

• Tracked – Opportunities that you want to watch.
• Active – Opportunities with which you are currently interacting: working on, applying for, and so forth. Active represents

a higher level of importance.

Both lists are available on the home page. See Pivot's User Interface.

When viewing search results, you can select one or more opportunities and then select Track to add the selected
opportunities to your Track list and Set to Active to add them to your Active list. When viewing an individual opportunity,
you can similarly select Track or Set to Active.

When viewing either list, you can use the row actions (in the Options menu in each row) to:

• Share an opportunity and see who you have shared the opportunity with
• Remove the opportunity from the list
• Move the opportunity to the other list
• Add or edit tags
• Add or edit deadline reminders
• Add the opportunity deadlines to an external calendar application; see Viewing and Exporting Opportunity Deadlines in

a Calendar.
• Toggle alerts on/off
• See how many other users have this opportunity in their Active or Tracked lists.

You can also select multiple opportunities in the list and perform some of these actions on all selected opportunities.

If an opportunity is no longer available and Ex Libris does not anticipate it being offered again the next year, it is no
longer searchable in Pivot. If an opportunity on your Active or Tracked lists expires, it automatically moves into an
Expired list. You can view the summary information of expired opportunities in this list, but it is no longer possible to
view the full funding opportunity.

Note

If an administrator has a funding opportunity in his or her Tracking or Active lists, he or she can also curate
the opportunity and view the names of the users who are tracking or marked as active the funding opportunity
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To share and/or tag tracked or active funding opportunities:

Sharing and tagging funding opportunities works exactly the same way that sharing and tagging saved searches works; see
Saving and Rerunning Searches for Funding Opportunities, above.

(regular users can not see which users are tracking an opportunity, but can see how many other users are
tracking the opportunity).

To see the list of users, select the relevant link in the row actions menu.

Also see the Tracked Opps Report (Admin > Reports > Funding Opps > Tracked Opps).

Other Users Tracking Opportunity

As an administrator, when sharing a list of funding opportunities, you can also select to add the opportunities
directly to the user(s) tracked lists. The opportunities appear with an indication that they were added by an
administrator.

Share Funding Opportunities
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Enabling or Disabling Email Funding Alerts
You enable or disable weekly alerts for tracked funding opportunities and on saved searches. A weekly email is also sent
for Advisor results, unless you disable it.

The alert for tracked and active funding opportunities is simply a reminder of what you have tracked. A saved search alert is
only sent if there are new funding opportunities that appear for that search.

To enable or disable the alert for a saved search or the Advisor:

In the Saved Searches tab on the home page select Alert email on or Alert email off in the row.

To enable or disable the alert for a tracked or active funding opportunity:

In the Tracked or Active tab on the home page select Turn alert email on or Turn alert email off in the row.

Managing Deadlines and Deadline Reminders
You can configure Pivot to automatically add deadline reminders to all opportunities that you add to your Tracked and/or
Active lists. To do this, see Managing Your Account. The following procedure can be used to manually add or edit deadline
reminders.

To add or edit a deadline reminder:

1. Select Add Deadline Reminder or Edit Deadline Reminder in the opportunity row. The Add Deadline Reminder or
Edit Deadline Reminder dialog box appears.

2. Select whether to receive the reminder as an announcement in the Pivot UI or as an email (or both), and select when
to receive the reminder.

3. When you are done, select Update.

Add Deadline Reminder

An administrator can add an unlimited number of local deadlines to individual funding opportunities. These
deadlines are visible only to your institution's users, in addition to the deadlines that are configured for the
opportunity.
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Viewing and Exporting Opportunity Deadlines in a Calendar
You can export a tracked or active funding opportunity to a calendar application. In addition, from any list of funding
opportunities, you can view the deadlines from one or more of these opportunities in a calendar in Pivot.

While viewing opportunity deadlines in a calendar in Pivot, you can export some or all of these deadlines in bulk to a
calendar application. You can export them as a dynamic calendar, which means that the deadlines are updated in your
calendar application when they are updated in Pivot. Or you can export them as static dates, in which case changes in
Pivot are not reflected in your calendar application.

To export a tracked or active funding opportunity deadline to an external calendar application:

1. When viewing the list of tracked or active funding opportunities, select Add to Calendar in an opportunity row. The
Add to Calendar dialog box appears.

2. Select to add the deadlines to your Google, iCal, Outlook, or Yahoo calendars. The external application opens and

You can add, edit, and delete local deadlines. You cannot edit deadlines that are pre-configured for the
opportunity.

To delete a local deadline, select Edit and select Delete.

Funding Opportunity(bottom)

Add to Calendar
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the information is added to the application.

To view one or more funding opportunity deadlines in a calendar within Pivot:

1. On any list of funding opportunities, select Calendar View to see all deadlines of a list of funding opportunities, as
follows:

◦ To view the deadlines of all opportunities in the list, select Calendar View > View Entire List.
◦ To view some of the opportunities, select the opportunities and then select Calendar View > View Selected

Opp(s).

The opportunity deadlines appear in a calendar within Pivot that opens in a new browser tab.

2. From the calendar you can perform any of the following actions:

Search Funding Results

Pivot Deadlines Calendar
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◦ Select Display Options, select Show opps N days before further deadlines, enter a number of days instead
of 0, and select Update Calendar to view the deadlines in the calendar earlier than the actual deadlines.

◦ Select Subscribe to add a calendar of these deadlines to a personal calendar application. The calendar of
deadlines is updated automatically whenever the information is changed in Pivot.

◦ Select Download to download the list of deadlines that you can then import into a personal calendar application.
This list is not dynamic, and is not updated when the information is changed in Pivot.

◦ Select Return to Result List to close this tab.
◦ You can navigate to previous and future months, as in any other calendar application.
◦ Select an opportunity in the calendar to view details about an opportunity.

Select View the Full Information to view the funding opportunity page.

Pivot Deadlines Calendar - Funding Opportunity Details

Ex Libris, a ProQuest Company


	Viewing and Managing Funding Opportunities
	Viewing Funding Opportunities
	Exporting Funding Opportunities
	Facet Filtering and Sorting

	Saving and Rerunning Searches for Funding Opportunities
	Tracking Funding Opportunities
	Tracking Funding Opportunities in Pivot
	Enabling or Disabling Email Funding Alerts
	Managing Deadlines and Deadline Reminders
	Viewing and Exporting Opportunity Deadlines in a Calendar


